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Lecture 19 (MWF) Independent sample t-test for testing equality of means in two populations

In general: Confidence intervals and testing

e |In most software packages that you run, the estimate will come with a
standard error. Below are two completely different methods. However
we observe standard errors (s.e.) in both
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Lecture 19 (MWF) Independent sample t-test for testing equality of means in two populations

What we do from now onwards will be more complicated than simply
analysing the sample mean.

However, essentially, the analysis will be the same. We assume that
the estimator is normally distributed. The standard error measures the
variation of the estimator and can be used to locate the mean. The rule
of thumb is that it is within a few standard errors of the mean.

We can usually construct a confidence interval for the true parameter 6
(0 is just a name a have given the parameter) with

lestimate — t4¢ X s.e., estimate + tq4¢ X s.e.]

Usually we use a t-distribution (but not always).
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If we test the hypothesis
Hy : 6 = number against H 4 : 8 # number

(often number = 0), then we need to measure the distance between
estimator and number with

estimate — number

S.C.

Usually the above will have a t-distribution (but not always).
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Independent two sample t-test: Comparing populations

Suppose we want to compare the heights of males and females at A& M.

e Question 1: Is the mean female height less than that of the male height?

Question 2: What is the difference in the mean male and mean female
heights.

First collect data: Then compare the sample mean of the male heights
with the sample mean of female heights and use this to infer aspects on
the mean height of male and female A&M students.
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Snapshot of data in JMP

Each row corresponds to a
student. Column 3 contains
the height. Column 4 their

gender.
In this file 1 = Female and
0 = Male. Column 4 is a

categorical /nominal variable,
so make sure that JMP knows
this (by changing the blue
triangle to the red blob).
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Plot of data collected
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The QQplot has the horizontal
lines because everyone
rounded their height to the
nearest inch.

Observe that each data set is
not exactly normal, but we do
not observe evidence of a large
skew, which would slow down
a CLT on the sample mean.

How these separate plots were
made in JMP will become
clear on the next slide.
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Summary of data and instructions in JMP

e To obtain a summary of the separate male and female heights in JMP.
Go to Analyze > Distribution. Then place variables in the following
in the box:

vvvvv
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> Quantiles v = Summary Statistics

Mean 5.9196296
Std Dev 0.2753946
Std Err Mean 0.0529997

Upper 95% Mean 6.0285721
Lower 95% Mean 5.81086872
N 27

» Quantiles ~ ~ Summary Statistics

Mean 5.452973
Sid Dewv 0.2200109
Std Err Mean 0.0361696

Upper 95% Mean 5.5263283
Lower 95% Mean 5.3796177
N 37

Remember, By will split the
data into the female and male
groups.

You should then see the
summary of the female and
male groups.
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e Let X be the height of a randomly selected female and Y the height
of randomly selected male. We observe from the output that there are
n = 37 females and m = 27 males in the sample.

The sample mean_for females is X = %Z?; X; = 5.45 and sample
mean for males is Y = %22221 Y; = 5.92.

The sample standard deviations are sx = 0.22 and sy = 0.27.
e Our objective is inference on the population means. Let ux be the

female population mean height and uy be the male population mean
height.

e Our object of interest is the quantity pux — py. It will tell us how much
larger or smaller females with respect to males.
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Are males taller than females?

This translates to testing Hg: ux — pny > 0 against Ha - ux — py <0
or equivalently Hy : py — pux < 0 against Ha : py — pux >0

We also want know the magnitude of the difference, this means
constructing a Cl for the mean difference ux — uy.

Clearly if X —Y > 0 we would be unable to reject the null and the
p-value would be larger than 50% (recall from Lecture 15 and 16 that
X —Y > 0 would lie within the non-rejection region).

If X —Y < 0, then we should use a statistical test.

How to make the comparison, what is the distribution of X — Y?
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Objectives

To build a confidence interval for the mean difference pux — py (this will
tell us where the mean difference lies).

To test the hypothesis that Hy : ux — py > 0 (mean female height and
male height are the same or mean female height is greater than mean
male height) against the alternative Ha : ux — py < 0.

We can take the test further and test whether Hy : ux — puy > —0.3
against H4 : px — py < —0.3.

This is asking if the average males is more than 0.3 feet taller than the
average female.

This is called an independent two-sample t-test.

10
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The necessary ingredients

e |n order to do the test Hy: ux — py > 0 against Ha : ux — py <0 or
to construct Cl for ux — py we need three magical ingredients:

(a) The difference of the sample averages: X — Y.

— — 0.2 0.2
(b) The standard errors of X —Y (this will turns out to be \/TX + X, where

ox Is the standard deviation in population X and oy is the standard
deviation in population Y').

(c) X and Y are normally distributed. Both samples are independent of
each other and independent within the sample. For example the values
X1,...,X, should have no influence on Y7,....,Y,, and X; should not
have any influence on the other observations in the sample X5, ..., X,,.

11
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An independent two-sample t-test in JMP

Distribution of ¥ for each X. Modeling types determine analysis.
Select Columns Cast Selected Columns into Roles Action

EHColtnns Y, Response | . Column 3 OK
Go to Analyze > Fit Y by X. You will
P T o W s then see the screen shot on the right.
< n s [
(S oot [

=

v ~/Oneway Analysis of Column 3 By Column 4

Plot of the two samples size by size.

This gives you a visual guide on their
e : ' differences. Remember, since there at
: 27 “0" heights and 37 “1" heights.
So each dot can represent several
: 7 students.

Column 4

6.5

Column 3

LN N

5.5
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[ ] @ student651.dat - Fit Y by X of Column 3 by Column 4 2
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To do the formal t-test click on the red
triangle and choose t-Test.  You will also see
Means/Anova/Pooled t. This option does the test
under the assumption that both samples share the
same standard deviation. We cover this later in the
lecture.

Difference X — Y = Female - Male (since is
1-0) = -0.466. Std. Err Diff = 0.064, which
corresponds to the standard error of X — Y. t

- —0.466 __
Ratio = 0064 — —7.2.

The t Ratio is extremely large. The p-value for
thetest Hy: ux —py >0vs Ha: ux —puy <0
is Prob< t < 0.001 (less than 0.1%).

13



Lecture 19 (MWF) Independent sample t-test for testing equality of means in two populations

Concepts: Distribution of sample means X — Y

e Suppose that X and Y are close to normal, then the difference of the
averages has the following distribution:

2 2
o1 , 03

X-Y~N|px—py,\|—+—=
n m

where o7 is the standard deviation of X (variability of population of X)
and o5 is the standard deviation of Y (variability of population Y).

e Important points:

e The distribution is centered about pux — iy, hence | am likely to draw
close to ux — uy.

14
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e How ‘close’ the sample means difference is to the true means is

2 2
determined by the standard error which is \/<% T 2).

m
The larger the sample sizes n and m the smaller the standard error (just
like in the one sample case, where we deal with just one sample mean
_ _ 2
X, which has standard error Z-).
e The normality result depends (as usual) on two factors
(a) How close the original data sets are to normality.

(b) How large the two sample sizes (both need to be sufficiently large).

e |f the sample size is small then the data must be close to normal. This
can be checked using QQplots.

15
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e Based on the above we make a Z-transform of the difference X — Y

T

3 |wqw

e In practice o1 and o3 is unknown and has to be estimated from the data.

e We estimate the two standard deviations, s; and s, from the data and
plug them into

N Y

to give the standard error.

16
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The distribution when the standard deviation is
estimated

We do the t-transform

(X =Y) = (px — py)
s2 s2
_1_|__2

The distribution of the above is not known exactly, it has an approximate

t-distribution with a rather complicated number of degrees of freedom.

This is the strange DF given in the JMP output.

JMP and most software will test Hy : ux —puy =0vs Hp : px —py # 0.

In this case replace ux — py in the t-transform with 0.

17
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Returning to the height example: Assumptions

e Unless many of the students in the 651 class were related it is reasonable
to assume that they are independent.

e To check whether the both the sample means X (female sample average)
and Y (male sample average) are normal we return to the data.

e To check normality of the data we make a QQplot of the residuals.

18



Lecture 19 (MWF) Independent sample t-test for testing equality of means in two populations

What are residuals

The analysis of residuals in an important component of most data
analysis.

The residuals are the observations in each group take away the group
sample mean.

For this example it is:
X; — X (female heights - female average)

and Y; — Y (male heights - male average).

The benefit of residuals is that they can be pooled and examined
altogether.

19
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Obtaining the residuals in JMP

¥ =Nnawau Anahieie af Nalumn 3 By Column 4
Quantiles |

Means/Anova/Pooled t
Means and Std Dev

+ t Test
Analysis of Means Methods
Compare Means
Nonparametric
Unequal Variances
Equivalence Test
Robust
Power...
Set a Level

Yrwyy

Go to the red triangle and choosing Save >
coF Pt ! Save Residuals. A new column is made in
S JMP of the residuals X;—X and Y;—Y . Since

Display Options » Save Standardized

Normal Quantile Plot

v v v v
T T

Save Normal Quantiles

, | Sove Predicte the mean has been removed the residuals have

I I
Save Script r | 04 02 00 02 04

.
imn3 Celumn4 Column 3 centered by Column 4 ZerO Sample mean (they Contaln nO mean
5.33 1 -0.122972073
5.33 1 -0.122972073 . .
517 1 -0.282972073 I n fo r m a t I O n ) .
5.75 1 0.207027027
5.42 1 -0.032972973
5.42 1 -0.032972973
5.5 1 0.047027027
5.5 1 0.047027027
5.58 1 0.127027027
5.75 0 -0.16962963
5.33 1 -0.122972073
5.92 0 0.0003703704
5.5 1 0.047027027
6.17 0 0.2503703704
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QQplot of residuals

he distribution of vall h colum
Select Columns C: Sel d Columns into Roles
5 Columns Y, Columns | | 4 Column 3 centered by Column 4
4 Column 1
4 Column 2
4 Column 3
i Column 4
4 Column 3 c...y Column 4 Weight | ‘
Freq | ‘
Histegrams Only
By ‘

T RIRU UL

v = Column 3 centered by Column 4

08
.
-
06 .
0.4

02

= l@
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-0.4

> Quantiles

¥ ~ Summary Statistics

Mean -1.4Be-15
Std Dev 0.242B165
Std Err Mean 0.0303521
Upper 85% Mean 0.0808537
Lower 95% Mean -0.060654
N 64

164128 067 00 067 1.281.64

LT

0015 005 016 03 05 07 084 085
Naormal Quantile Plot

Analyze > Distribution and select
the new residual column. This will
give the histogram of the residuals.
To obtain the QQplot go to the red
triangle and choose Quantile Normal
Plot (see Lecture 10).

We observe that the residuals are not
to close to normality. However, the
sample sizes of 27 and 37 should make
the respective sample means close to
normal. Observe (as mentioned on
the previous slide) that the mean is
zZero.
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Matching the output of the t-test to the formal test

Oneway Analysis of Column 3 By Column 4

6.5
T 64 -
5 :
8 ] ‘. ;
5.5 )
5 7] ! 1
Column 4
Missing Rows 1
t Test
1-0
Assuming unequal variances /Th
Difference -D.46666 t Ratio -7.27271 f1h
Std Err Dif 0.06417 DF 48.29255
Upper CL Dif -0.33766 Prob = It = 0001*
Lower CL Dif -0.59565 Prob =t 1.0000 — I..--" — e~
Confidence 0.95 Prob <t =0001" 0.4 o 0.0 o 0.4
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Interpreting the output

The df = 48.29

The standard error which measures the variability of the estimator of the
differences is

/ 484
\/00 8 00758_0.064.

The difference in sample means is —0.466.

The t-value for the test Hy : ux — puy > 0 against Ha : ux — puy <0 is
= (—0.466 — 0)/0.064 = —7.27.

23
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e Since the alternative is pointing to the left, we need to area to the left
of -7.27, this is Prob < 0.0001 (in the output). Therefore, the p-value is
less than 0.0001, which means at the 1% level there is sufficient evidence
to suggest that males are taller than females.

e The 95% confidence for the difference in the means is [—0.59, —0.33],
this means with 95% confidence we believe the mean difference in female
and male heights lies between [—0.59, —0.33].

24
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Reasons for the extremely small p-value

TASIIEWAY MIdIYSID U1 WwUIULTINT 9 DY \WwUluinin <+ Observe that the the difference in ma |e
: and female heights is large = -0.466.
. . Moreover the standard error is small Std.
2 8 . .
E : . Err Diff = 0.064. The small standard
. ‘ error is due to the relatively large sample
: sizes (27 and 37).
s s . These two ingredients lead to an
Column 4 . .
+ [ Toat extremely large t Ratio = 0%%26 = —7.2.
lfsumingunequalvariances ThIS meanS the t-Value |S |n the extreme
Difference  -0.46666 t Ratio ~ -7.27271 . . . . .
DR 00017 AN 4020250 tail of the t-distribution, which leads to a
Lower CL Dif -0.59565 Prob>t  1.0000 N
R piie 0.95 SN 04 -02 00 02 04 Sma” p-Value.

Further the Cl is [—0.59, —0.33] which is “far” from zero.
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Using the same output for additional tests

e Suppoe we believe that the mean difference is over 0.3 feet. Is there
evidence in the data that this could be true:

We test Hy : ux — puy > —0.3 against Ha : ux — py < —0.3, we do
the test at the 5% level. We calculate the t-value

—0.46 — (—0.3)
t = = —2.5.
0.064

e To deduce the p-value we use the critical values for the t-distribution
with 48.28df.

probability | 0.15 | 0.10 | 0.05 | 0.025 | 0.01 | 0.005

t* 105 1.3 [ 168 | 201 | 24 | 2.68

26
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e Since -2.5 lies between -2.68 and -2.4, the area to the left of -2.5 is
between 0.5% to 1%. Thus the p-value is between 0.5% - 1%. Based on
this there is evidence to suggest that the mean difference between males
and females is greater than 0.3 feet.

27



Confidence intervals at other levels

Lecture 19 (MWF) Independent sample t-test for testing equality of means in two populations

e Just as before to obtain the 99% confidence interval we use the critical

value for 0.005 (remember 0.005=0.5%).

e \We use the critical value corresponding to the t-distribution with 48.28df.

probability

0.15

0.10

0.05

0.025

0.01

0.005

t*

1.05

1.3

1.68

2.01

2.4

2.68

e This gives the 99% confidence interval:
[—0.466 — 2.68 x 0.064, —0.466 + 2.68 x 0.064] = [—0.63, —0.29]

which (of course) is wider than the 95% CI, which is [-0.6,0.34].
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Lecture 19 (MWF) Independent sample t-test for testing equality of means in two populations

Variants of the t-test: Pooling information

e Some improvements to the testing can procedure can made if there is
reason to believe that the standard deviation in both populations is the
same.

e Looking back to the comparison between male and female data we
observe that the sample standard deviation of the male and female
heights was 0.27 and 0.22 respectively; which are relatively close.

o |f we believe that their corresponding population deviations are close or
the same rather than use separate standard deviation estimates in the
test, we can “pool” the information and estimate one standard deviation
for both population.

29
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Formulas behind the pooled test

e The pooled sample standard deviation measures the collective spread of
the residuals ({X; — X} and {Y; — Y }):

n

i=1 j=1

e The independent two sample t-test becomes
XY —(px tpy) X Y - (px )

2
S 1 1
Wp_'— Sp\/ n i m

3 ks

e Under the null and the assumption the sample means are normal the
distribution of the t-transform ¢ has a t-distribution with n + m — 2

30



Lecture 19 (MWF) Independent sample t-test for testing equality of means in two populations

degrees of freedom. This is a little more palatable than the strange
degrees of freedom we encountered above.

If the population variances are the same, the pooled t-test gives “more
correct p-values”.

It also has more power (ability to reject the null when the alternative is
true) than the regular t-test.

One caveat is that we really have to sure that the standard deviations
in both populations are the same. If they are not, the pooling method
makes no sense.
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The pooled t-test in JMP

B &+ @42 p Y
© = nasian Amatunia n Catsimn 3 By Column 4
Quantiles
Means/Anova/Pooled t Shows or hides a t test, ar
Me: v

r = Oneway Analysis of Column 3 By Column 4

6.5

.
B8 L ——

Column 3

— ——
.

55 _

G o 1

Celumn 4
v Oneway Anova
» Summary of Fit

v t Test
1-0
Assuming equal v
Difference -D 46566 l Ratio -7.53247
Std Err Dif 0.06195 DF 62
Upper CL Dif -0.34282 Prob > |t|
Lower CL Dif -0.59050 Prob >t 1.0000
Confidence 0.95 Prob <t

-04 -02 00 0.2 0.4

To do the formal t-test click on the red triangle,
do exactly what was done previously but choose
Means/Anova/Pooled t instead of t-test.

lgnore the ANOVA stuff you see and focus on the
t-test. Difference X —Y = Female - Male (since
is 1-0) = -0.466. Std. Err Diff = 0.0619, which
corresponds to the standard error of X — Y.

t Ratio = T %:23% = —7.53.

The t Ratio is extremely large. The p-value for
thetest Hy: ux —py >20vs Ha: ux —puy <0
is Prob< ¢t < 0.001 (less than 0.1%). We reject
the null.
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Lecture 19 (MWF) Independent sample t-test for testing equality of means in two populations

Choosing the sample sizes

e [ he standard error is

o7 03

= + _4

n m
~~ ~~
variability of X  variability of Y

(if the population standard deviations are known).

e As usual there are two factors which effect the size, the standard
deviations o7 and o5 and the sample sizes n and m. You cannot control
the standard deviation (variability) of the population (unless you did
something drastic, such as getting rid of the extremes in the population)
but, often you can control the sample sizes.
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Lecture 19 (MWF) Independent sample t-test for testing equality of means in two populations

e Suppose that the standard deviations of both populations are the same,

then the standard error is a\/% + % Suppose n + m = 100, how to
choose the sample sizes to make this as small as possible?

Extreme examples are:
— If n =50 and m =50, {/z5 + 25 = 0.2
—Ifn=99and m=1, y/55 + 1 =101
e In the case that the standard deviations are the same, the standard error

is smallest (and this the difference in the sample means is most reliable)
when they both have sample sizes.

e Remember, in the case that the standard deviations are the same, having
equal sample sizes leads to estimators with the smallest standard errors.
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Lecture 19 (MWF) Independent sample t-test for testing equality of means in two populations

However, in the case that the standard deviations are not the same,
equal sample sizes will not lead to the smallest standard deviation.

e The total variability/reliability on the estimator of the difference is
accounted for in the standard error:

03

_ + _“4
m

~~ ~~

variability of X  variability of Y
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Lecture 19 (MWF) Independent sample t-test for testing equality of means in two populations

Example: Are two diets the same?

Two diets are being compare for effectiveness. 20 volunteers were
randomly assigned to go on Diet 1 or Diet 2. There are 10 people in each
group. After one month their weight loss (in kilos) was recorded. The data

is given below.

Diet| | 29 |27 |39 |27 |21]26]|22|42)|50]0.7
Dietll | 3525|3881 (36|25|50|29 23] 3

e Let yu; be the mean weight loss of diet | and p;; be the mean weight
loss of diet Il. Test the hypothesis that the diets are different.

e Thedatais

https://www.stat.tamu.edu/~suhasini/teaching651/diet_data.dat
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Lecture 19 (MWF) Independent sample t-test for testing equality of means in two populations

Plot of Diet data

The summary statistics and histogram is give below.

Distributions Column 2=0

Column 1

— Summary Statistics
H=—= - Mean 372
Std Dew 1.7344868

Std Err Mean 0.5484929

Upper 95% Mean 4.9607771
Lower 95% Mean 2.47932229

] | " "
2 3 4 5 [+ T!' Ell 9
Distributions Column 2=1
Column 1
— Summary Statistics
@l Mean 2.9
Std Dev 1.21288937
Std Err Mean 0.3835507

Upper 25% Mean 3.7676519
Lower 25% Mean 2.0323481
M 10

SR B A .
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Checking the assumptions for the Diet Data

QQplot of each group and the residuals

Distributions Column 2=0
Column 1

1.28  -0.67 00 0.67 1.28

NN
N

. {@

01 02 0304050607 08 08

Normal Quantile Plot

Distributions Column 2=1
Column 1

1.26  -0.67 00 0.67  1.28

I
-
=

01 020304050607 08 09

Normal Quantile Plot

Distributions

Column 1 centered by Column 2

5
4
3

- 20—

Summary Statistics
Mean 3.997e-16
Std Dev 1.4566725
Sid Err Mean 0.3257219
Upper 95% Mean 0.6817437
Lower 95% Mean -0.681744
N 20

164-128 -067 0.0

067 1.28 1.64

0.04 01 025 04 055 0.7 0.82 0.82

Normal Quantile Plot
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Lecture 19 (MWF) Independent sample t-test for testing equality of means in two populations

e Since the people are not related and they were randomly allocated to
one of the two diets it seems reasonable to assume that both data sets
are independent.

e To check the normality assumption (for this small data set) we have
made a QQplot. From the limited data that we have, it does not appear
to be normal, this means that sample means (average weight loss for
both diets will only be too close to normality). This will have an impact
on the accuracy of the p-values that we obtain.

e However, there does not appear to be any huge outliers that may have
significant impact on the outcome of the test (as we shall see later one
outlier can have an dramatic impact on the test).
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Lecture 19 (MWF) Independent sample t-test for testing equality of means in two populations

The JMP output

Oneway Analysis of Column 1 By Column 2

o
_E,_
T_
ﬁ__
E %7
= 4| )
S ;
3 1 ;
2_ " 1
1 -
o [ T 1
Caoluwmn 2
it Test
1-0
Assuming unegqual variances T
Difference -0.8200 t Ratio -1.22517F rd “xx
Std Err Dif 0.66893 DF 16.10337 " A
Upper CL Dif 0.5981 Prob = Il 0.2381 [ \\
Lower CL Dif -2.2381 Prob =1t 0.8809 ; : : ! , | ] | S
Confidence 0.95 Prob =t o.1191 . -1 o 1 >
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Lecture 19 (MWF) Independent sample t-test for testing equality of means in two populations

The hypothesis test and confidence interval

e Just for revision purposes the critical values for the t with 16.1df is

probability | 0.15 | 0.10 | 0.05 | 0.025 | 0.01 | 0.005

t* 1.07 | 133 | 1.74 | 212 | 258 | 291

e We test the hypothesis Hy : uy — puyr = 0 against Hy : uy — prr # 0,
we do the test at the 5% level. We have the t-transform ¢ = (—0.82 —
0)/0.66 = —1.22. This lies between -1.33 and -1.07. Therefore the area
to the left of —1.22 is between 10 to 15%. Thus the p-value is between
20-30% (as seen by the JMP output which tells us it is 23%). As this
is larger than 5% we cannot reject the null at the 5% level. Though we
cannot accept the null, the data is consistent with there not being any
difference between the two diets.
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Lecture 19 (MWF) Independent sample t-test for testing equality of means in two populations

e The 95% confidence interval for the mean difference between the diets
is [—2.2,0.59] pounds.

e What if we wanted to test if Hy : uy—purr < 0against Hy - py—prr > 0
at the 5% level?

e What if we wanted to test if Hy : ur—purr > 0 against Hy - pr—prr <0
at the 5% level?
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Lecture 19 (MWF) Independent sample t-test for testing equality of means in two populations

Example: Breakfast cereal and location on shelf

We want to understand whether location of cereal packet has an influence
on amount of sugar the cereal contains.

There are usually top, middle and top shelves.
My conjecture is that the middle shelf will contain the most sugar as this
is the eye level of children which companies like to seduce with sugar.

Based on this the hypotheses of interest are

Ho : pariddie — rop < 0 against H 4 : pariddie — tTop > 0.

The data is here

https://www.stat.tamu.edu/~suhasini/teaching651/Cereal _Brands.csv
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~ Oneway Analysis of sugars By shelf . . .
ality of means in two populations

15 L -
. .
. .
. .
. . .
10 L .
- . .
& - .
=4 . .
L . . .
5 . .
.
. . .
. .

.
0 . . .
Bottom Middle Top Each Pair
shalf Student's t

0.05
v Means Comparisons
v =/ Comparisons for each pair using Student's t
» Confidence Quantile
» LSD Threshold Matrix
» Connecting Letters Report

v Ordered Differences Report

Level -Level Difference Std Err Dif Lower CL Upper CL p-Value

Middle Bottom 4513784  1.293167 1.93651 7.091064

Middle Top 3.091270 1.121470 0.85618 5.326357 =
Top Bottomn 1.422515 1.158149 -0.BB567 3.730703 0.2233 [

Note The p-values that JMP give are for the two-sided tests. Therefore,
you need to figure out the results for one-sided tests using this and the
summary statistics.
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Lecture 19 (MWF) Independent sample t-test for testing equality of means in two populations

Warning: Never apply a t-test to residuals
The residuals remove all mean information from the data. The difference

in the sample means of the residuals will be zero - therefore the p-value
of a 2-sided test will be 100% (and the p-value in a one-sided test will be
50%). To see this in action, here is the output of the independent sample
t-test of the residuals of the diet data (considered above):

O newway Analysis of Colurmm 1
centered by Colummn 2 By Colurmmnm 2
L=

LU 1] L]
LI TR T}

Column 1 cantered by Column 2
BN = Q4N @ b

0

Codurmir 2

T Test
1-0

Assuming unequal variances.
Cifference A . Ad4e-16 & Ratio B.64e-16
Stad Err NF o.e593 [OF A& 10337
Uppeaer &L T 1.4181 Prob = |[t] 1.0000
Lowwer (L [Df -1.4181 Prob =t O SOOD0

Confidence 0D.95 Prob <= t O.S000 > -1 o 1 =

Naturally the test CANNOT detect a difference in the means, because there
is no difference.
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